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Art+Design 3-D Output Lab - Procedures, Policies and Guidelines 

School of Art+Design provides educational resources consisting of laboratories, classrooms, presentation rooms, studios and equipment.
Room 311 Art and Design Building is the 3-Dimensional Output Laboratory.
The lab has a Stratasys Dimension SST three-dimensional (FDM with ABS plastic) printer and a Universal Laser Systems X-660 cutter.

Entering and Using the 3-Dimensional Output Laboratory

The 3-D output lab and equipment are available ONLY to students with valid computer lab privileges for the current semester. 
You are required to present your i-Card each time you want to use resources. Your university student account will be charged for resources and materials used in the lab.

YOU MAY NOT USE ANOTHER PERSON’S ACCOUNT AND YOU CANNOT AUTHORIZE ANYONE TO USE YOUR i-Card OR ACCOUNT PRIVILEGES.
Access is on a “first to come is first to be served” basis. It is sometimes difficult to gauge how long each project will take to complete, so plan your 3-D output projects well in advance.

Software to communicate with and drive 3-D Output Lab devices is available in the computer labs. Guides and templates are available through links on the School’s website. 

3-D Output Lab resources operate through consultation with a lab assistant. The lab assistant will setup and execute your project on the equipment.
Only the student who is currently consulting with the lab assistant is allowed to enter the equipment area beyond the help desk.
The lab assistant can only help one person at a time. When many students want to use the lab at the same time, they are required to remain outside of room 311.
Students will not be allowed into the equipment area until it is her or his turn for a consultation.
Users will not be allowed to sit at the 3-D Output Lab workstations to make time-consuming changes - allowing minor adjustments will be at the discretion of the assistant.

On the laser cutter, you will be required to act as the “safety” observer for the duration of your use to allow the assistant to be available for consultation and other tasks.

You cannot drop off files and materials and leave the lab - you will be required to remain with your project for the entire time it takes to execute.
Use a PC Windows-formatted USB key or other external media for transporting data from your workstation to the 3-D Output Lab.
On 3-D Output Lab workstations, you will not be allowed to log into personal server directories or email accounts to download files for use in the lab.

Activities within the labs and use of Art+Design resources are restricted to educational pursuits and class work only.
Only approved materials can be laser cut. Plastics must have original identifying label. Please note that there is no equipment in the 3-D Output Lab to cut down materials.

The lab assistant will determine whether or not a material and method is appropriate to be tried. There is a limited supply of approved laser materials for sale. 
If you want to try something not on the approved list: first, you must consult with staff, supply material and allow five business days for testing before it can be determined if you may proceed. 

Watch for special alerts that could affect your use of equipment or resources. 

During times when resources are in high demand (to accommodate as many people as possible), it may become necessary to group requests together before printing or cutting.
Lab assistants cannot extend open hours. If the assistant thinks your project will take longer than the open hours remaining that day, you may be required to return at a later date.

The School of Art+Design cannot be held responsible for lost time or the unavailability of malfunctioning equipment or services.
Use of the 3-D Output Lab is solely at the user’s risk. Failed results cannot be reimbursed in any manner, including but not limited to:
time charges, variances in material causes unexpected results or user supplied material is ruined because of an improper setup or execution by the lab assistant.
This means that when using lab equipment, the School will not replace or reimburse you for a failed cutting session or an improperly modeled print that fails.

Credit for equipment use time or lab supplied materials will be at the discretion of Art+Design Staff - lab assistants cannot issue credit.

The lab assistant will place materials and prints into equipment (like laser bed or print bath). Please ask for permission before using any lab equipment, tools or tables.
There is no storage area available for materials or projects. Completed laser jobs or items remaining in the lab will be placed in or near the Lost&Found (locker 3214)

3D print jobs that are not picked up within two weeks of completion will be discarded.

FOOD AND DRINKS ARE NOT ALLOWED in the 3-D Output Lab at any time by anyone.
Cell phones should not be used in the labs, please turn off ringtones and take all your calls outside of the laboratory to avoid disturbing others.
Activities within the Art+Design Building are monitored for your security and safety and are subject to video surveillance.

Lab personnel will answer your technical questions to the best of his or her ability or may refer you to your instructor, a staff member or other informational resources, but

the School of Art+Design, staff and assistants cannot be held responsible for the consequences or the outcome of suggested solutions to questions or problems. 
If you encounter a problem, have other concerns or special needs, please consult first with your instructor or a lab assistant for possible solutions.

You can use the online Art+Design Forums to report problems and to submit feedback < www-s.art.uiuc.edu/labs/forum/>

Failure to comply with any policy may result in the loss of your privileges.
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Quick Start Guide for Using Art + Design’s Laser Cutter

Start your project by consulting with a 3D Output Lab Assistant for advice about the best way to plan your project.
The laser system can’t cut everything. Examples of materials that cannot be attempted are metal, glass, and stone.
You are required to read and comply with the Art+Design 3D Output Lab Procedures, Policies and Guidelines.

Use the Adobe Illustrator laser cutter template file ( “AdobeLaserTemplate.ait” ) that is available on the School’s website.
This template file has the correct laser color swatches and is formatted to the necessary 32”x 32” Document Size.
The template also has a separate layer for each color and if used, can help you more easily correct problem objects.
Plan for 1/4 inch margins of unused material for all laser projects. To prevent warping, plan with the smallest size possible.
The cutter bed is 18” tall by 32” wide, but the laser cannot cut materials all the way to the edge of the bed.
Your Illustrator document’s “lasering” area cannot exceed 17.75” tall by 31.75” wide.

Your file’s colors “tell” the laser cutter what to do. Also, an object’s “thickness” or width is another laser controlling factor.
Colors that the laser understands are broken down into three “driver” settings: Power + Speed + Laser Pulses per inch.
Width values and thicknesses “tell” the laser cutter that the object is either a “Raster” or “Vector” command.
There are four very specific colors that interface and “drive” the laser cutter in this order:
	 Black Raster objects etch first; followed by Green Raster etches;
	 then Blue Vector engraving happens and Cyan Vector elements are cut last.

Black is designated as the Raster Shallow “Shape” Etch color and removes a small amount of material from the surface.
Green is the Raster Deep “Shape” Etch color and removes more material from the surface than the shallow etch.
Blue is designated as the Vector Line Engraving color AND is useful for making rapid “score” and surface marks.
Cyan is the Vector Line Cutting color and the laser beam will cut all the way through the material sheet.
Talk to a lab assistant about using colors to control how the laser cutter proceeds with your file.

Photo images “Placed” in your Illustrator file are treated as varying levels of gray and interpreted as Black Etches.
Solidly filled objects, shapes, thick lines and text are always treated as Raster Etches, 
	 but can be made to etch “shallow” by using “Black” or the same object will etch deeper with a “Green” “Fill”.
Raster etching takes a long time, because the lens must move incrementally back and forth to remove material from the surface.
Blue Vector Engraving and Cyan Vector Cutting commands generally take less time than etching.
However, there is a significant difference in the total time it takes the laser cutter to complete the same file 
	 on thin paper than on thick plastic because thick materials generally require slower speeds and more power.

The four basic Red-Blue-Green (RGB) colors Art + Design 3D Output Lab currently uses to “drive” laser functions are: 
	 Black R=0, G=0, B=0 for Raster Shallow Area Etch (and all “photo” images);
	 Green R=0, B=0, G=255 for Raster Deep Area Etch;
	 Blue R=0, B=255, G=0 for Vector Line Engrave; 
	 Cyan R=0, B=255, G=255 for Vector Line Cut.
Colors must conform to these specific RGB colors or the laser cutter will produce unwanted results. 

All Vector cutting and engraving line weights should be .0001 inch “Stroke” width maximum with NO “Fill”.
Thicker Stroke weights may be interpreted as “raster” etch objects rather than “vector” cut lines.
Important: “white” or color fills will cause errors when trying to vector cut.
General Rule - due to the “warp” factor (inherent to unstable materials like wood, cellulose-based boards and some plastics):
	 cutting many small sheets produces better results than cutting everything from one large sheet.

page 3 of 10



Laser Cutting Light Weight Materials at the 3D Output Lab

Laser cutting light weight materials like paper, film, cloth and leather is difficult because the exhaust 
system pulls so strongly it lifts the material from the bed. The bad results include: sheet moves from the 
original position while it is being cut; partially cut but attached pieces strike the moving lens carriage 
( bad for lens ); pieces cut free during the process get pulled into the exhaust; sheet won’t stay flat dur-
ing process and with some media, there is a ‘flapping’ action that causes changes in the focus point as 
the sheet moves up and down.

In addition to badly cut files, small pieces get sucked into the exhaust system. Which is a danger of pos-
sible fire caused by smoldering media ( especially paper or cloth ) after being pulled into the pipeline 
and ignited by the oxygen forced upon it. This fire danger is an important reason why all jobs MUST be 
watched during the ENTIRE laser process, so someone will see pieces flying off the project as they are 
sucked into the vacuum system.

General recommendation for planning a project is “small and many.” As materials are heated and 
cool during the process, they warp and this will cause inaccuracies ( or failures ) in the final results ( 
especially seen in large sheets with many cuts and/or etches ). Because of warping, cutting many small 
boards with a few items is preferable to one large board with many cuts or etches to be made. In other 
words, better results are obtained by using the smallest sheet size possible and using multiple files as 
necessary to get the number of pieces needed for the project.

Examples of light weight material includes: laser and inkjet papers; card stock, film, charcoal, draw-
ing and watercolor papers, fabrics and leather. Consult first with a lab assistant before deciding which 
method is best for your project. The final decision about whether or not your chosen method and mate-
rial is acceptable to be attempted will be completely at the discretion of the assistant in charge of the 
3D Output Lab. 

Secure Sheet

LIGHT WEIGHT MATERIALS MUST USE SOME METHOD TO KEEP THE SHEET FLAT AND SECURE ON THE 
BED AND THE FILE MUST BE MADE SO CUT PIECES WON’T COME LOOSE OR STRIKE THE LENS CAR-
RIAGE AS IT MOVES ABOVE THE PROJECT. The lab will use an adhesive putty to secure your project to 
the cutting bed, but there is NOTHING THAT WILL KEEP A WARPED BOARD FLAT!
You will not be allowed to use non-approved materials ( objects, metal, stone ) as “weights” to hold 
down materials, because of the potential for damage to the system.

Tape is useful for holding the many cut pieces of finished jobs while they are still on the bed as a com-
plete sheet. When the completed sheet is lifted, everything will stay in place for transport and pieces 
can be easily identified later. YOU MUST SUPPLY TAPE FOR POST-PRODUCTION SAVING AND 
TRANSPORT OF COMPLETED PROJECTS.
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An appropriate method of CUTTING light weight material MUST be chosen: 
1)	 LAYERED - material placed between two heavier boards, produces inconsistent results
		  and surface can NOT be etched or engraved;
2)	 GLUED - material adhered to heavy board, can be etched and engraved, 
		  but requires extra steps and possible material stretching during gluing process;
3)	 BROKEN LINES - REQUIRES file using vector line breaks,
		  material is held by a pre-made template or other approved fastening method.

LIGHTWEIGHT MATERIALS WILL NOT BE ALLOWED TO BE CUT,
UNTIL ALL CRITERIA FOR SECURING ARE MET:
		  (1) ALL MATERIALS ARE SECURED FLAT TO CUTTING BED;
AND	 (2a) MATERIAL IS ‘LAYERED’ BETWEEN HEAVY BOARDS; 
OR		  (2b) MATERIAL IS ‘GLUED’ TO BOARD;
OR		  (2c) FILE WILL ‘BROKEN LINE’ CUT WITH A TEMPLATE OR OTHER APPROVED METHOD 
		  AND PIECES WILL REMAIN ATTACHED TO THE ORIGINAL SHEET SECURED TO THE BED.

Caution: FIRST consult with a lab assistant regarding which compositions CANNOT be used like PVC-
based cloth, vinyl leather and upholstery fabric.

Layered Method

Place a light weight sheet between two pieces of flat, ( NOT WARPED ) mat or chip board. You will be 
cutting through the top board, through the desired material sheet and lightly into the bottom board ( but 
not through bottom board ). This procedure holds the ‘middle’ light weight sheet in place, but sacrifices 
the two boards. Layering works especially well for saving small pieces that have vector lines that are 
not properly “broken” when created ( see “broken line method” ) and the small pieces are kept in place 
by the weight of the top board and are caught by the bottom board as they are freed from the 
material sheet.

A problem with the layering or ‘sandwich’ method is getting consistent results when cutting through 
multiple sheets of whatever materials you bring as ‘heavy’ boards. Also, layering will NOT allow ‘etch-
ing’ or ‘engraving’ elements on the surface of the light weight sheet. The lab assistant will have to do 
some experiments in advance of attempting your project and it’s a good idea to bring extra sheets and 
boards with you. 

Glued Method

Gluing is a good procedure to use for flexible materials ( fabric, leather ) and it allows you to etch and 
engrave the surface. It helps to begin the process by flattening the material using a hot iron. In some 
cases, it may be desirable to to stiffen the material with water-soluble spray starch. The starch helps 
keep the material from stretching and deforming before the next step: gluing to a board. If you don’t 
stiffen the material before gluing, then material that is stretched during the gluing process will return to 
its original shape after laser cutting, leaving the project deformed and out of shape.
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Attach the stiffened and flattened material to some sort of appropriate, stiff, cheap substrate like heavy 
weight, chip board for support during the cutting process. “UHU” brand glue stick or “YES” brand 
school paste work well, because both adhesives are acid free and remain water-soluble after the glue 
dries. Do NOT use glues that can’t be dissolved in water. Do not choose water-based glue labeled 
‘permanent’ because it contains PVA ( Poly Vinyl Acetate ), which starts out water soluble, but turns into 
plastic when dry ( like latex or acrylic paints ) and will not dissolve later.

Apply a thin layer of glue to the board ( if ‘YES’ paste is chosen, use an adhesive trowel that has little 
grooves in it to keep the glue thickness uniform as you pull across the surface of the board ). Then care-
fully apply the material from one end of the board to the other ( without trapping air between the mate-
rial and the board ). Allow material and board to dry flat and under pressure ( between sheets of glass 
with weight on top ) before attempting to laser cut.

When the project is done laser cutting, submerge and soak the entire board in a sink until the material 
floats freely from the board. Then discard the boards and thoroughly wash the starch and glue from the 
material and set aside to dry on a flat surface ( glass works well ).

Remember to plan on the smallest possible size sheets to prevent warping! Have your board(s) and 
planned method ready before you come to the lab. [Note: you will NOT be allowed to do any of the 
gluing, mounting, soaking or washing processes in the 3D Output Lab.]

The downside of the glued process is the many steps, extra tools and wet material that later must be 
dried and flattened. Drying can lead to shrinkage and distortion of the end product, especially with 
leather. A positive aspect of ‘gluing’ allows you to etch and engrave the material surface.

A quicker and easier method uses spray adhesive ( rubber cement ) and if done correctly, only a small 
amount of adhesive residue should stick to the finished light weight material. Apply a VERY light coat-
ing of spray adhesive to the board and allow the glue to set to tackiness. Then carefully roll the material 
onto the board without trapping air bubbles or stretching ( pre-stiffening material helps ). The adhesive 
spray should be light enough to grab the material, but not so heavy as to ‘glue’ it to the board. The 
material can then be lifted from the board after cutting ( solvent may be necessary if glue adheres 
to the material ).

Important for all glued and mounted projects: in addition to the mounted material, a small sample piece 
of the material should NOT be mounted, so the lab assistant has something to measure for thickness 
and the appropriate laser cutter setting to be applied.

Broken Vector Lines Method

“Line breaking” means making tiny interruptions in a ( normally continuous ) vector line to keep the 
pieces from being completely cut from the original sheet. When the job is done, you can use a sharp 
blade to cut the purposefully attached pieces from the original sheet. Loose pieces pose a significant 
danger to the laser system when they are free to be pulled into the exhaust or allowed to strike the 
lens passing above.
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To prevent damage to the equipment from loose pieces that are pulled toward the vacuuming exhaust: 
you are REQUIRED to create files for light weight materials using the “broken line” method, because 
there is always a chance that pieces will “fly” away during the process.  For example: a rectangle will 
need at least four “breaks” to prevent it from being pulled away from the original.

In addition to “breaking vector lines”, the remaining sheet must be completely secured to the bed by 
adhesive putty or a template before you will be allowed to proceed.

Note: refer to “Making Line Breaks for the Laser Cutter” later in this guide that shows you the basic 
Illustrator Tools to get started in properly preparing your files.

Using Templates to Secure Material

There is a physical template available ( made of quarter-inch acrylic ) that holds down only the edges 
of Letter-sized, light weight materials while they are being cut. Coordinating with the template: there is 
a pre-made Illustrator File Template titled “LhtWtLetterTemplate.ait” available on the School’s website 
that locates the usable area boundaries ( that is 1/16’’ smaller than each side of Letter size ) for a ma-
terial sheet that is 8.5x11 inches.

Important: using templates requires the you to create a file using the ‘broken line’ method ( small gaps 
in the continuous vector line ) to prevent pieces from being pulled into the exhaust system or striking the 
lens after pieces are cut from the original sheet.

On the software side: “Copy and Paste” your file elements within the template’s usable rectangle. THE 
“BROKEN LINE” METHOD MUST BE USED WITH TEMPLATES: BE CERTAIN NO PIECES WILL DETACH DUR-
ING THE PROCESS that could cause damage to the laser cutter or the exhaust system. Also make sure 
that none of your laser elements are outside the template’s boundary box ( or the laser will cut into the 
template and ruin it ).

You can create custom acrylic templates for specific purposes, but the the material the template is made 
of must fall within approved materials criteria and won’t damage anything if accidentally struck by the 
laser. The “template” can’t be made of metal, stone or objects that could ‘bounce back’ the laser beam, 
move during the process or interfere with device movement.

Exhaust Air Choke

An air flow controller or “choke” is part of the exhaust system. The lab assistant may choose to 
lessen the air flow to help complete a project successfully in coordination with one or more of 
the methods described above. This is entirely at the discretion of the assistant consulting on your 
project. Light weight material cutting projects will only be allowed to proceed when all safety 
criteria are met with best practices.
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Step 2
select object

Step 3
place first anchor

Step 4
place second anchor

Step 5
select line segment

Step 6
delete segment

Making Line Breaks for the Laser Cutter

“Line breaking” means making tiny interruptions in a ( normally continuous ) line to keep the pieces from being 
completely cut from the original sheet.  For example - a rectangle will need at least four “breaks”: one for each side.
Making files with interrupted lines will prevent potential damage to the laser cutter when using thin materials.

1)	 You are going to use the Add Anchor Point Tool to create two new anchor points on a line.
	 Then you will delete the small segment in between the anchors to create a break.
	 You can easily identify paths and anchors by turning on Smart Guides in the View menu.
	 You may want to “Zoom In” on your object to precisely control the next steps.
	 Turn off all “Snap to ...” commands in View menus to help create very small, precise breaks.

2)	 With the Illustrator Selection Tool, choose the shape or object that you want to modify.

3)	 Then select the Add Anchor Point Tool and place the first anchor point along the path.

4)	 Place a second anchor point on the same line path, 
	 approximately 1/32th of an inch away from the first anchor.
	 Note: 1/32” is the minimum line break width needed to keep objects attached to the original sheet material.
	 To assist with estimating 1/32” line breaks, go to Preferences, Grid menu
	 and change the Vertical and Horizontal Document Grids into a Gridline Every 1 inch with 32 Subdivisions.

5)	 Select the line segment “path” in between the two anchors.

6)	 Press the Delete key to remove the segment and create the vector line break.
	 Repeat Steps 2 through 6 as needed for your file to prevent equipment damage when 
	 cutting light weight or thin material sheets.  After “lasering”, you can use a razor or 
	 Xacto blade to carefully cut the “line breaks” and remove the objects from your sheet.
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How to Make Text Stencils with the Laser Cutter

Step 2
create text

Step 3
create vector outlines

Step 4
make “spanner” set

and place on text

page 9 of 10

The following instructions show you how to create laser cut “stencils” from typefaces and text fonts using Illustrator.
However, if you choose a light weight material, you must also use one of the methods described in this guide
to prevent fires and to protect the laser cutter system from damage.

1)	 You are going to use the Text Tool to create your type and you’ll turn the font into outlines as vector graphics.
	 Next you will place tiny rectangles to span and connect letters with inside cutouts like letters: a, B, d, O, g, etc..
	 You will subtract the rectangle shapes using Pathfinder.
	 You will then change all the stroke and weight values to the proper settings to “drive” the laser cutter.
	 IMPORTANT: If you choose a material that is considered light weight, you must use an approved method.

	 Depending upon your choice of typeface, fonts smaller than 24 to 36 point become difficult to reliably stencil cut.
	 You may want to “Zoom In” on your object to easily control the next steps.
	 Turn off all “Snap to ...” commands in View menus, so you can precisely place your connectors on the text.
	 1/16 of an inch is about the minimum stencil width that will withstand the laser without breaking or burning up.
	 Go to Preferences, Grid menu and change the Vertical and Horizontal Document Grids 
		  into a Gridline Every 1 inch with 16 Subdivisions to assist you with making proper width rectangles to span the letters.

2)	 Use the Illustrator Type Tool to create the text you want to turn into a stencil.

3)	 With the text selected, go to Create Outlines in the Type menu.

4)	 Select the Illustrator Rectangle Tool and create a set of connectors 
		  or “spanners” to speed up the stenciling process 
		  and to help give your project a consistent look throughout the text.

	 In the example, the four basic spanners were created from the first one.
	 It was copied, pasted and rotated at 30°, 60° and 90° to make a set of four connectors.
	 You can then copy, paste and place a basic rectangle to connect inner portions of letters that need “stenciling”.
	 You can create as many different kinds of spanners that you feel are necessary for your project.

	 You can also use the Pen Tool to make “freehand” spanners and spanner sets.



Step 5
using Pathfinder

to subtract spanners

Step 6
change stroke weight 

and color values

Step 7
finished stencil
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5)	 Go to the Window menu and make the Pathfinder menu visible.
	 Make certain that the outlined text and all spanners are selected.
	 Click on Subtract from shape area button in the Shape Modes menu.

6)	 Be sure all text and spanners are still selected.
	 Change all Stroke Colors to “Laser Cyan” [ R=0, B=255, G=255 ] with NO FILL.
	 Change all Stroke Weights to .0001 inch ( or point size unit ).

7)	 Your text should now look something like the example to the left >
		  [ note: example is shown in a bolder stroke weight for clarity ]

IMPORTANT: If you are using material that is considered light weight, 
	 you must choose to have your project laser cut using the “layered” method 
	 or you must now continue by creating “line breaks” on this file. 

Approved methods are described in detail in this guide at:
	 “Laser Cutting Light Weight Materials at the 3D Output Lab” and 
	 “Making Line Breaks for the Laser Cutter”.

To protect the equipment and to prevent fires, an approved method for cutting light weight materials 
	 must be applied before your project will be allowed to be attempted in the lab.
	
Consult in advance with the 3D Output Lab Assistant for guidance about the best way to plan your specific project.


